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This chapter documents key design methodologies and techniques for Altera® 
devices using the LeonardoSpectrum and Quartus II design flow. 

This chapter includes the following sections:

■ “Altera Device Family Support”

■ “Design Flow” on page 17–2

■ “LeonardoSpectrum Optimization Strategies” on page 17–4

■ “Timing Analysis with the LeonardoSpectrum Software” on page 17–6

■ “Exporting Designs Using NativeLink Integration” on page 17–7

■ “Guidelines for Altera Megafunctions and LPM Functions” on page 17–8

■ “Block-Based Design with the Quartus II Software” on page 17–16

f Altera recommends using the advanced Mentor Graphics Precision RTL Synthesis 
software for new designs in new device families. For more information about 
Precision RTL Synthesis, refer to the Mentor Graphics Precision Synthesis Support 
chapter in volume 1 of the Quartus II Handbook.

1 This chapter assumes that you have set up, licensed, and are familiar with the 
LeonardoSpectrum software.

f To obtain and license the LeonardoSpectrum software, refer to the Mentor Graphics 
website at www.mentor.com. For information about installing the LeonardoSpectrum 
software and setting up your working environment, refer to the LeonardoSpectrum 
Installation Guide and the LeonardoSpectrum User’s Manual.

Altera Device Family Support
The LeonardoSpectrum software is a mature synthesis tool supporting legacy devices 
and many current devices; however, newly-released devices may not be supported.

1 Contact Mentor Graphics for more information about support for newly-released 
devices.

The LeonardoSpectrum software also supports the FLEX 8000 and MAX 9000 legacy 
devices that are supported only in the Altera MAX+PLUS® II software, as well as 
ACEX® 1K, APEX™ II, APEX 20K, APEX 20KC, APEX 20KE, FLEX® 10K, and 
FLEX 6000 legacy devices that are supported by the Quartus II software version 9.0 
and earlier.
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Design Flow
The following steps describe a basic Quartus II software design flow using the 
LeonardoSpectrum software:

1. Create Verilog HDL or VHDL design files.

2. Import the Verilog HDL or VHDL design files into the LeonardoSpectrum 
software for synthesis.

3. Select a target device and add timing constraints and compiler directives to help 
optimize the design during synthesis.

4. Synthesize the project in the LeonardoSpectrum software.

5. Create a Quartus II project and import the technology-specific EDIF Input File 
(.edf) netlist and the Tcl Script File (.tcl) generated by the LeonardoSpectrum 
software into the Quartus II software for placement and routing and performance 
evaluation.

6. After obtaining place-and-route results that meet your requirements, configure or 
program the Altera device.

Figure 17–1 on page 17–3 shows the recommended design flow using the 
LeonardoSpectrum and Quartus II software.

If your area and timing requirements are met, use the programming files generated by 
the Quartus II software to program or configure the Altera device. If the area or 
timing requirements are not met, change the constraints in the LeonardoSpectrum 
software and rerun synthesis. Repeat the process until the area and timing 
requirements are met. You can also use other Quartus II software options and 
techniques to meet the area and timing requirements.
Quartus II Handbook Version 11.1 November 2011 Altera Corporation
Volume 1: Design and Synthesis



Chapter 17: Mentor Graphics LeonardoSpectrum Support 17–3
Design Flow
The LeonardoSpectrum software supports both VHDL and Verilog HDL source files. 
With the appropriate license, the software also supports mixed synthesis, allowing a 
combination of VHDL and Verilog HDL source files. During synthesis, the 
LeonardoSpectrum software produces several intermediate and output files, which 
are listed and described in Table 17–1.

Figure 17–1. Recommended Design Flow Using LeonardoSpectrum and Quartus II Software
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Table 17–1. LeonardoSpectrum Intermediate and Output Files

File Extension(s) File Description

.xdb Technology-independent register transfer level (RTL) netlist file that can only be read by the 
LeonardoSpectrum software.

.edf Technology-specific output netlist file in electronic design interchange format (EDIF).

.tcl
Forward-annotated constraints file containing constraints and assignments. 

A .tcl file for the Quartus II software is created for all devices. The .tcl file contains the appropriate 
Tcl commands to create and set up a Quartus II project and pass placement constraints. 

.acf
Assignment and Configurations file for backward compatibility with the MAX+PLUS II software. 
For devices supported by the MAX+PLUS II software, the MAX+PLUS II assignments are imported 
from the MAX+PLUS II .acf file.
November 2011 Altera Corporation Quartus II Handbook Version 11.1
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LeonardoSpectrum Optimization Strategies
Altera recommends that you do not use project directory names that include spaces. 
Some file operations in the LeonardoSpectrum software do not work correctly if the 
path name contains spaces.

Specify timing constraints and compiler directives for the design in the 
LeonardoSpectrum software, or in a constraint file (.ctr). These constraints are 
forward-annotated in the .tcl file for use with the Classic Timing Analyzer in the 
Quartus II software version 10.0 and earlier.

1 The LeonardoSpectrum software does not generate a Synopsys Design Constraint 
(SDC) format file for the TimeQuest Timing Analyzer. If you are using a current 
version of the Quartus II software, you must convert your timing constraints to SDC 
format. Altera recommends using the advanced Precision RTL Synthesis software for 
new designs in new device families, instead of using the LeonardoSpectrum software.

The LeonardoInsight™ Schematic Viewer is an add-on graphical tool for schematic 
views of the technology-independent RTL netlist (.xdb) and the technology-specific 
gate-level results. You can use the Schematic Viewer to visually analyze and debug 
the design. It also supports cross-probing between the RTL and gate-level schematics, 
the design browser, and the source code in the HDLInventor™ text editor.

LeonardoSpectrum Optimization Strategies
You can configure most general settings in the Quick Setup tab in the 
LeonardoSpectrum user interface. FlowTabs provide additional options, some 
including multiple PowerTabs at the bottom of the screen, with more options. 
Advanced optimization options in the LeonardoSpectrum software include 
timing-driven synthesis, encoding style, resource sharing, and mapping I/O registers.

Timing-Driven Synthesis
The LeonardoSpectrum software supports timing-driven synthesis through 
user-assigned timing constraints that optimize the performance of the design. 
Constraints, such as clock frequency, can be specified globally or for individual clock 
signals. The following sections describe how to set the various types of timing 
constraints in the LeonardoSpectrum software.

The timing constraints described in “Global PowerTab” are set in the Constraints 
FlowTab. In this FlowTab, there are PowerTabs at the bottom, such as Global and 
Clock, for setting various constraints.

Global PowerTab
The Global PowerTab is the default PowerTab in the Constraints FlowTab where you 
can specify the global clock frequency. The Clock Frequency setting on the Quick 
Setup tab is equivalent to the Registers to Registers delay setting. You can also 
specify the Input Ports to Registers, Registers to Output Ports, and Inputs to 
Outputs delays that correspond to global tSU, tCO, and tPD requirements, respectively, 
in the Quartus II software. The timing diagram on the Global PowerTab reflects the 
settings you have made.
Quartus II Handbook Version 11.1 November 2011 Altera Corporation
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LeonardoSpectrum Optimization Strategies
Clock PowerTab
You can set various constraints for each clock in your design. First, select the clock 
name in the Clock(s) window. The clock names appear after the design is read from 
the Input FlowTab. Configure settings for that particular clock and click Apply. You 
can also specify the Duty Cycle, which is set to 5-% by default. The timing diagram 
shows these settings.

If a clock has an Offset from the main clock, which is considered to be time “0”, this 
constraint corresponds to the OFFSET_FROM_BASE_CLOCK setting in the Quartus II 
software.

You can specify the pin number for the clock input pin in the Pin Location box. This 
pin number is passed to the Quartus II software for place-and-route, but does not 
affect synthesis in the LeonardoSpectrum software.

Input and Output PowerTabs
Configure settings for individual input or output pins in the Input and Output tabs. 
First, select a name in the Input Ports or Output Ports window. The names appear 
after the design is read from the Input FlowTab. Then, make the following settings for 
that pin as described below.

The Arrival Time indicates that the input signal arrives a specified time after the 
rising clock edge (time “0”). This setting constrains the path from the pin to the first 
register by including the arrival time in the total delay, and corresponds to the 
EXTERNAL_INPUT_DELAY assignment in the Quartus II software.

The Required Time indicates the maximum delay after time “0” that the output 
signal should arrive at the output pin. This setting directly constrains the register to 
output delay, and corresponds to the EXTERNAL_OUTPUT_DELAY assignment in the 
Quartus II software.

Specify the pin number for the I/O pin in the Pin Location box. This pin number is 
passed to the Quartus II software for place-and-route, but does not affect synthesis in 
the LeonardoSpectrum software.

Other Constraints
The following sections describe other constraints that can be set with the 
LeonardoSpectrum user interface:

■ “Encoding Style”

■ “Resource Sharing” on page 17–6

■ “Mapping I/O Registers” on page 17–6

Encoding Style
The LeonardoSpectrum software encodes state machines during the synthesis 
process. To improve performance when coding state machines, separate state machine 
logic from all arithmetic functions and data paths. When encoded, a design cannot be 
re-encoded later in the optimization process. You must follow a particular VHDL or 
Verilog HDL coding style for the LeonardoSpectrum software to identify the state 
machine.
November 2011 Altera Corporation Quartus II Handbook Version 11.1
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Timing Analysis with the LeonardoSpectrum Software
Table 17–2 describes the state machine encoding styles supported by the 
LeonardoSpectrum software.

The Encoding Style is created in the Input FlowTab. The setting instructs the software 
to use a particular state machine encoding style for all state machines. The default 
Auto encoding style implements binary or one-hot encoding, depending on the size of 
enumerated types in the state machine.

f To ensure proper recognition and improve performance when coding state machines, 
refer to the Recommended HDL Coding Styles chapter in volume 1 of the Quartus II 
Handbook for design guidelines.

Resource Sharing
You should turn on Resource Sharing in the Input FlowTab to allow optimization, 
which reduces device resources.

Mapping I/O Registers
The Map I/O Registers option in the Technology FlowTab, is available for Altera 
FPGAs containing I/O cells (IOC) or I/O elements (IOE). If this option is turned on, 
input or output registers are moved into the device’s I/O cells for faster setup or 
clock-to-output times.

Timing Analysis with the LeonardoSpectrum Software
The LeonardoSpectrum software reports successful synthesis with an information 
message in the Transcript or Information window. Estimated device usage and timing 
results are reported in the Device Utilization section of this window. Figure 17–2 on 
page 17–7 shows an example of a LeonardoSpectrum compilation report.

Table 17–2. State Machine Encoding Styles in the LeonardoSpectrum Software

Style Description

Binary Generates state machines with the fewest possible flipflops. Binary state machines are useful for 
area-critical designs when timing is not the primary concern.

Gray Generates state machines where only one flipflop changes during each transition. Gray-encoded state 
machines tend to be free of glitches.

One-hot
Generates state machines containing one flipflop for each state. One-hot state machines provide the best 
performance and shortest clock-to-output delays. However, one-hot implementations are usually larger 
than binary implementations.

Random Generates state machines using random state machine encoding. Use random state machine encoding 
only when no other implementation achieves the desired results.

Auto (Default) Implements binary or one-hot encoding, depending on the size of enumerated types in the state machine.
Quartus II Handbook Version 11.1 November 2011 Altera Corporation
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Exporting Designs Using NativeLink Integration
The LeonardoSpectrum software estimates the timing results based on timing models. 
The software does not have the design’s place-and-route information in the Quartus II 
software, so it cannot report accurate routing delays. Additionally, if the design 
includes any black boxed Altera-specific functions, the LeonardoSpectrum software 
does not report timing information for these functions.

Exporting Designs Using NativeLink Integration
You can use NativeLink® integration to integrate the LeonardoSpectrum and the 
Quartus II software with a single GUI for both the synthesis and place-and-route 
operations. You can run the Quartus II software from within the LeonardoSpectrum 
software GUI with NativeLink integration or you can run the LeonardoSpectrum 
software from within the Quartus II software GUI for device families supported in the 
Quartus II software.

Generating Netlist Files
The LeonardoSpectrum software generates an .edf netlist file readable as an input file 
in the Quartus II software for place-and-route. Select the .edf file option name in the 
Output FlowTab. The .edf file is also generated if the Auto option is turned on in the 
Output FlowTab. 

Including Design Files for Black Boxed Modules
Be sure to include the MegaWizard™ Plug-In Manager-generated custom 
megafunction variation design file in the Quartus II project directory, or add it to the 
list of project files for place-and-route, if the design has black boxed megafunctions.

Figure 17–2. LeonardoSpectrum Compilation Report
November 2011 Altera Corporation Quartus II Handbook Version 11.1
Volume 1: Design and Synthesis
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Guidelines for Altera Megafunctions and LPM Functions
Passing Constraints with Scripts
The LeonardoSpectrum software can create a Tcl script (.tcl) file called <project 
name>.tcl. This file contains commands to create a Quartus II project along with 
constraints and other assignments. To output a .tcl file, turn on Write Vendor 
Constraint Files in the Output FlowTab.

To create and compile a Quartus II project using the .tcl file generated from the 
LeonardoSpectrum software, perform the following steps in the Quartus II software:

1. Place the .edf and .tcl files in the same directory.

2. On the View menu, point to Utility Windows, and click Tcl Console to open the 
Quartus II Tcl Console.

3. At the Tcl prompt, type source <path>/<project name>.tcl.

4. On the File menu, click Open Project to open the new project. 

5. On the Processing menu, click Start Compilation.

1 The LeonardoSpectrum software does not generate a Synopsys Design Constraint 
(SDC) format file for the TimeQuest Timing Analyzer. If you are using a current 
version of the Quartus II software, you must convert your timing constraints to SDC 
format. Altera recommends using the advanced Precision RTL Synthesis software for 
new designs in new device families, instead of using the LeonardoSpectrum software.

Integration with the Quartus II Software
You can launch the Quartus II software from within the LeonardoSpectrum software 
with the options in the Place And Route section of the Quick Setup tab. Turn on the 
Run Integrated Place and Route option to start the compilation in the Quartus II 
software to show the fitting and performance results. You can also run 
place-and-route in the Quartus II software by turning on Run Quartus on the 
Physical FlowTab, and then clicking Run PR.

To use integrated place-and-route, on the Options menu, point to Place and Route 
Path and click Tools. Specify the location of the Quartus II software executable file 
(<Quartus II software installation directory>/bin).

Guidelines for Altera Megafunctions and LPM Functions
Altera provides parameterizable megafunctions ranging from simple arithmetic units, 
such as adders and counters, to advanced phase-locked loop (PLL) blocks, 
multipliers, and memory structures. These functions are performance-optimized for 
Altera devices. Megafunctions include the library of parameterized modules (LPM), 
device-specific megafunctions such as PLLs, LVDS, and digital signal processing 
(DSP) blocks, intellectual property (IP) available as Altera MegaCore® functions, and 
IP available through the Altera Megafunction Partners Program (AMPPsm).

1 Some IP cores require synthesis in the LeonardoSpectrum software. Refer to the user 
guide for the specific IP.
Quartus II Handbook Version 11.1 November 2011 Altera Corporation
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Guidelines for Altera Megafunctions and LPM Functions
You can infer or instantiate megafunctions in the LeonardoSpectrum software. The 
LeonardoSpectrum software supports inferring some Altera megafunctions, such as 
multipliers, DSP functions, and RAM and ROM blocks. The LeonardoSpectrum 
software supports all Altera megafunctions through instantiation.

Instantiating Altera Megafunctions
There are two methods of instantiating Altera megafunctions in the 
LeonardoSpectrum software. The more common method, which maintains target 
technology awareness, is to set up and parameterize a megafunction variation in the 
MegaWizard Plug-In Manager in the Quartus II software. The megafunction wizard 
creates a wrapper file that instantiates the megafunction. The less common method is 
to directly instantiate the megafunction in the Verilog HDL or VHDL code. The 
advantage of using the megafunction wizard method over the instantiation method is 
that the megafunction wizard properly sets all the parameters. Also you do not need 
the library support, which is required in the instantiation method. This is referred to 
as black box methodology.

1 Altera recommends using the MegaWizard Plug-In Manager to ensure that the ports 
and parameters are set correctly.

f When directly instantiating megafunctions, refer to the respective megafunction user 
guide on the Altera IP and Megafunction page.

Inferring Altera Memory Elements
The LeonardoSpectrum software can infer memory blocks from Verilog HDL or 
VHDL code. When the LeonardoSpectrum software detects a RAM or ROM from the 
style of the RTL code at a technology-independent level, the software maps the 
element to a generic module in the RTL database. During the technology-mapping 
phase of synthesis, the LeonardoSpectrum software maps the generic module to the 
most optimal primitive memory cells, or Altera megafunction, for the target Altera 
technology.

f For more information about inferring RAM and ROM megafunctions, including 
examples of VHDL and Verilog HDL code, see the Recommended HDL Coding Styles 
chapter in volume 1 of the Quartus II Handbook.

Inferring RAM

The LeonardoSpectrum software supports RAM inference for various device families. 
The following are the restrictions for the LeonardoSpectrum software to successfully 
infer RAM in a design:

■ The write process must be synchronous.

■ The read process can be asynchronous or synchronous, depending on the target 
Altera architecture.

■ Resets on the memory are not supported.

The Stratix series and Cyclone series devices support the RAM primitive altsyncram 
with a minimum RAM size of two bits, and a minimum RAM address width of 
one bit.

To disable RAM inference, set the extract_ram and infer_ram variables to false. 
November 2011 Altera Corporation Quartus II Handbook Version 11.1
Volume 1: Design and Synthesis
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To enter the value false when performing synthesis in the user interface with the 
Advanced FlowTabs, on the Tools menu, click Variable Editor, or add the set 
extract_ram false and set infer_ram false commands to your synthesis script.

Inferring ROM

You can implement ROM behavior in HDL source code with CASE statements or 
specify the ROM as a table. The LeonardoSpectrum software infers both synchronous 
and asynchronous ROM, depending on the target Altera device. For example, 
memory for Stratix series devices must be synchronous to be inferred.

To disable ROM inference, set the extract_rom variable to false. To enter the value 
false when performing synthesis in the user interface with the Advanced FlowTabs, 
on the Tools menu, click Variable Editor, or add the set extract_rom false 
commands to your synthesis script.

Inferring Multipliers and DSP Functions
Some Altera devices include dedicated DSP blocks optimized for DSP applications. 
The following Altera megafunctions are used with DSP block modes:

■ LPM_MULT

■ ALTMULT_ACCUM

■ ALTMULT_ADD

You can instantiate these megafunctions in the design or direct the LeonardoSpectrum 
software to infer the appropriate megafunction by recognizing a multiplier, 
multiplier-accumulator (MAC), or multiplier-adder in the design. The Quartus II 
software maps the functions to the DSP blocks in the device during place-and-route.

f For more information about inferring multipliers and DSP functions, including 
examples of VHDL and Verilog HDL code, refer to the Recommended HDL Coding 
Styles chapter in volume 1 of the Quartus II Handbook.

Simple Multipliers
The LPM_MULT megafunction implements the DSP block in the simple multiplier 
mode. The following functionality is supported in this mode:

■ The DSP block includes registers for the input and output stages, and an 
intermediate pipeline stage.

■ Signed and unsigned arithmetic is supported.

Multiplier Accumulators
The ALTMULT_ACCUM megafunction implements the DSP block in the 
multiply-accumulator mode. The following functionality is supported in this mode:

■ The DSP block includes registers for the input and output stages, and an 
intermediate pipeline stage.

■ The output registers are required for the accumulator.

■ The input and pipeline registers are optional.

■ Signed and unsigned arithmetic is supported.
Quartus II Handbook Version 11.1 November 2011 Altera Corporation
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1 If the design requires input registers to be used as shift registers, use the black box 
method to instantiate the ALTMULT_ACCUM megafunction.

Multiplier Adders
The LeonardoSpectrum software can infer multiplier adders and map them to either 
the two-multiplier adder mode or the four-multiplier adder mode of the DSP blocks. 
The LeonardoSpectrum software maps the HDL code to the correct ALTMULT_ADD 
function.

The following functionality is supported in these modes:

■ The DSP block includes registers for the input and output stages, and an 
intermediate pipeline stage.

■ Signed and unsigned arithmetic is supported, but support for the Verilog HDL 
signed construct is limited.

Controlling DSP Block Inference
Device features, such as dedicated DSP blocks, multipliers, multiply-accumulators, 
and multiply-adders can be implemented in DSP blocks or in logic. You can control 
this implementation through attribute settings in the LeonardoSpectrum software.

As described in Table 17–3, attribute settings in the LeonardoSpectrum software 
control the implementation of the multipliers in DSP blocks or logic at the signal block 
(or module), and project level.

Global Attribute
You can set the extract_mac global attribute to control the implementation of 
multipliers in DSP blocks for the entire project. You can set this attribute with the 
following script command:

set extract_mac <value>

Table 17–3. Attribute Settings for DSP Blocks in the LeonardoSpectrum Software (1)

Level Attribute Name Value Description

Global extract_mac (2) TRUE All multipliers in the project are mapped to DSP blocks.

FALSE All multipliers in the project are mapped to logic.

Module extract_mac (3) TRUE Multipliers inside the specified module are mapped to DSP blocks.

FALSE Multipliers inside the specified module are mapped to logic.

Signal dedicated_mult

ON LPM is inferred and multipliers are implemented in DSP block.

OFF
LPM is inferred, but multipliers are implemented in logic by the Quartus II 
software.

LCELL
LPM is not inferred, and multipliers are implemented in logic by the 
LeonardoSpectrum software.

AUTO
LPM is inferred, but the Quartus II software automatically maps the multipliers 
to either logic or DSP blocks based on the Quartus II software place-and-route.

Notes to Table 17–3:

(1) The extract_mac attribute takes precedence over the dedicated_mult attribute.
(2) For devices with DSP blocks, the extract_mac attribute is set to “true” by default for the entire project.
(3) For devices with DSP blocks, the extract_mac attribute is set to “true” by default for all modules.
November 2011 Altera Corporation Quartus II Handbook Version 11.1
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Module Level Attributes
You can control the implementation of multipliers inside a module or component by 
setting the extract_mac attribute in the Verilog HDL source code. Setting this 
attribute for a module affects only the multipliers inside that module. Use the 
following command:

//synthesis attribute <module name> extract_mac <value>

The Verilog HDL and VHDL code samples in Example 17–1 and Example 17–2 show 
how to use the extract_mac attribute.

Example 17–1. Using Module Level Attributes in Verilog HDL Code

module mult_add ( dataa, datab, datac, datad, result);
//synthesis attribute mult_add extract_mac FALSE
// Port Declaration
input [15:0] dataa;
input [15:0] datab;
input [15:0] datac;
input [15:0] datad;

output [32:0] result;

// Wire Declaration
wire [31:0] mult0_result;
wire [31:0] mult1_result;

// Implementation
// Each of these can go into one of the 4 mults in a
// DSP block
assign mult0_result = dataa * `signed datab;
//synthesis attribute mult0_result preserve_signal TRUE

assign mult1_result = datac * datad;

// This adder can go into the one-level adder in a DSP
// block
assign result = (mult0_result + mult1_result);

endmodule
Quartus II Handbook Version 11.1 November 2011 Altera Corporation
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Signal Level Attributes
You can control the implementation of individual LPM_MULT multipliers with the 
dedicated_mult attribute, as shown in the following example:

//synthesis attribute <signal_name> dedicated_mult <value>

1 The dedicated_mult attribute is only applicable to signals or wires; it is not applicable 
to registers.

Table 17–4 describes the supported values for the dedicated_mult attribute.

Example 17–2. Using Module Level Attributes in VHDL Code

library ieee ;
USE ieee.std_logic_1164.all;

USE ieee.std_logic_arith.all;

entity mult_acc is
   generic (size : integer := 4) ;
   port (
      a: in std_logic_vector (size-1 downto 0) ;
      b: in std_logic_vector (size-1 downto 0) ;
      clk : in std_logic;

accum_out: inout std_logic_vector (2*size downto 0)
   ) ;
   attribute extract_mac : boolean;
   attribute extract_mac of mult_acc : entity is FALSE;
end mult_acc;

architecture synthesis of mult_acc is
    signal a_int, b_int : signed (size-1 downto 0);
    signal pdt_int : signed (2*size-1 downto 0);
    signal adder_out : signed (2*size downto 0);

begin
    a_int <= signed (a);
    b_int <= signed (b);
    pdt_int <= a_int * b_int;
    adder_out <= pdt_int + signed(accum_out);
    process (clk) 
    begin
       if (clk'event and clk = '1') then
          accum_out <= std_logic_vector (adder_out);
       end if;
    end process;
end synthesis ;

Table 17–4. Values for the dedicated_mult Attribute (Part 1 of 2)

Value Description

ON LPM is inferred and multipliers are implemented in the DSP block.

OFF
LPM is inferred and multipliers are synthesized, implemented in logic, and optimized by the Quartus II software. 
(1)

LCELL
LPM is not inferred and multipliers are synthesized, implemented in logic, and optimized by the 
LeonardoSpectrum software. (1)
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1 Some signals for which the dedicated_mult attribute is set may be removed during 
synthesis by the LeonardoSpectrum software due to design optimization. In such 
cases, if you want to force the implementation, you can preserve the signal from being 
removed during synthesis by setting the preserve_signal attribute to true.

The extract_mac attribute must be set to false for the module or project level when 
using the dedicated_mult attribute.

Example 17–3 and Example 17–4 are samples of Verilog HDL and VHDL codes, 
respectively, using the dedicated_mult attribute.

AUTO
LPM is inferred, but the Quartus II software maps the multipliers automatically to either the DSP block or logic 
based on resource availability.

Note to Table 17–4:

(1) Although both dedicated_mult=OFF and dedicated_mult=LCELLS result in logic implementations, the optimized results in these two cases may 
differ.

Table 17–4. Values for the dedicated_mult Attribute (Part 2 of 2)

Value Description

Example 17–3. Signal Attributes for Controlling DSP Block Inference in Verilog HDL Code

module mult (AX, AY, BX, BY, m, n, o, p);
input [7:0] AX, AY, BX, BY;
output [15:0] m, n, o, p;
wire [15:0] m_i = AX * AY; // synthesis attribute m_i dedicated_mult ON
// synthesis attribute m_i preserve_signal TRUE
//Note that the preserve_signal attribute prevents
// signal m_i from being removed during synthesis
wire [15:0] n_i = BX * BY; // synthesis attribute n_i dedicated_mult OFF
wire [15:0] o_i = AX * BY; // synthesis attribute o_i dedicated_mult AUTO
wire [15:0] p_i = BX * AY; // synthesis attribute p_i dedicated_mult
LCELL
// since n_i , o_i , p_i signals are not preserved,
// they may be removed during synthesis based on the design
assign m = m_i;
assign n = n_i;
assign o = o_i;
assign p = p_i;
endmodule
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Guidelines for Using DSP Blocks
In addition to the guidelines mentioned earlier in this section, use the following 
guidelines when designing with DSP blocks in the LeonardoSpectrum software:

■ To access all the control signals for the DSP block, such as sign A, sign B, and 
dynamic addnsub, use the black box technique.

■ While performing signed operations, ensure that the specified data width of the 
output port matches the data width of the expected result. Otherwise, the sign bit 
might be lost or data might be incorrect because the sign is not extended. For 
example, if the data widths of input A and B are width_a and width_b, respectively, 
the maximum data width of the result can be (width_a + width_b +2) for the 
four-multipliers adder mode. Thus, the data width of the output port should be 
less than or equal to (width_a + width_b +2).

■ While using the accumulator, the data width of the output port should be equal to 
or greater than (width_a + width_b). The maximum width of the accumulator can 
be (width_a + width_b + 16). Accumulators wider than this are implemented in 
logic. 

Example 17–4. Signal Attributes for Controlling DSP Block Inference in VHDL Code

library ieee ;
USE ieee.std_logic_1164.all;
USE ieee.std_logic_arith.all;
USE ieee.std_logic_unsigned.all;
USE ieee.std_logic_signed.all;
ENTITY mult is

PORT( AX,AY,BX,BY: IN
std_logic_vector (17 DOWNTO 0);
m,n,o,p: OUT
std_logic_vector (35 DOWNTO 0));
attribute dedicated_mult: string;
attribute preserve_signal : boolean
END mult;
ARCHITECTURE struct of mult is

signal m_i, n_i, o_i, p_i : unsigned (35 downto 0);
attribute dedicated_mult of m_i:signal is "ON";
attribute dedicated_mult of n_i:signal is "OFF";
attribute dedicated_mult of o_i:signal is "AUTO";
attribute dedicated_mult of p_i:signal is "LCELL";

begin

m_i <= unsigned (AX) * unsigned (AY);
n_i <= unsigned (BX) * unsigned (BY);
o_i <= unsigned (AX) * unsigned (BY);
p_i <= unsigned (BX) * unsigned (AY);

m <= std_logic_vector(m_i);
n <= std_logic_vector(n_i);
o <= std_logic_vector(o_i);
p <= std_logic_vector(p_i);
end struct;
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■ If the design uses more multipliers than are available in a particular device, the 
Quartus II software may issue a no fit error. In such cases, use the attribute settings 
in the LeonardoSpectrum software to control the mapping of multipliers in your 
design to DSP blocks or logic.

Block-Based Design with the Quartus II Software
The incremental compilation design flow with LogicLock™ constraints enables users 
to design, optimize, and lock down a design one section at a time. You can 
independently create and implement each logic module into a hierarchical or 
team-based design. With this method, you can preserve the performance of each 
module during system integration and have more control over the placement of your 
design. To maximize the benefits of the incremental compilation in the Quartus II 
software, you can partition a new design into a hierarchy of netlist files during 
synthesis in the LeonardoSpectrum software.

You can create different netlist files with the LeonardoSpectrum software for different 
sections of a design hierarchy. Having different netlist files means that each section is 
independent of the others. When synthesizing the entire project, only portions of a 
design that have been updated must be resynthesized when you compile the design. 
You can make changes, optimize, and resynthesize your section of a design without 
affecting other sections.

f For more information about incremental compilation, refer to the Quartus II 
Incremental Compilation for Hierarchical and Team-Based Design chapter in volume 1 of 
the Quartus II Handbook. For more information about the LogicLock feature, refer to 
the Analyzing and Optimizing the Design Floorplan chapter in volume 2 of the Quartus II 
Handbook.

Hierarchy and Design Considerations
You must plan your design’s structure and partitioning carefully to use incremental 
compilation and LogicLock features effectively. Optimal hierarchical design practices 
include partitioning the blocks at functional boundaries, registering the boundaries of 
each block, minimizing the I/O between each block, separating timing-critical blocks, 
and keeping the critical path within one hierarchical block.

f For more recommendations for hierarchical design partitioning, refer to the Design 
Recommendations for Altera Devices and the Quartus II Design Assistant chapter in 
volume 1 of the Quartus II Handbook.

To ensure the proper functioning of the synthesis tool, you can apply the LogicLock 
option in the LeonardoSpectrum software only to modules, entities, or netlist files. In 
addition, each module or entity should have its own design file. It is difficult to 
maintain incremental synthesis if two different modules are in the same design file, 
but are defined as being part of different regions, because both regions must be 
recompiled when you change one of the modules or entities.
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If you use boundary tri-states in a lower-level block, the LeonardoSpectrum software 
pushes, or bubbles, the tri-states through the hierarchy to the top-level to take 
advantage of the tri-state drivers on the output pins of the Altera device. Because 
bubbling tri-states require optimizing through hierarchies, lower-level tri-states are 
not supported with a block-level design methodology. You should use tri-state drivers 
only at the external output pins of the device and in the top-level block in the 
hierarchy.

If the hierarchy is flattened during synthesis, logic is optimized across boundaries, 
preventing you from making LogicLock assignments to the flattened blocks. Altera 
recommends preserving the hierarchy when compiling the design. In the Optimize 
command of your script, use the Hierarchy Preserve command, or in the user 
interface, specify Preserve in the Hierarchy section of the Optimize FlowTab.

If you are compiling your design with a script, you can use an alternative method for 
preventing optimization across boundaries. In this case, use the Auto hierarchy 
setting and set the auto_dissolve attribute to false on the instances or views that 
you want to preserve (that is, the modules with LogicLock assignments) using the 
following syntax:

set_attribute -name auto_dissolve -value false \
.work.<block1>.INTERFACE

This alternative method flattens your design according to the auto_dissolve limits, 
but does not optimize across boundaries where you apply the attribute.

f For more details about LeonardoSpectrum attributes and hierarchy levels, refer to the 
LeonardoSpectrum documentation in the Help menu.

Creating a Design with Multiple .edf Files
The first stage of a hierarchical design flow is to generate multiple .edf files, which 
allows you to take advantage of the incremental compilation flow in the Quartus II 
software. If the whole design is in one .edf file, changes in one block affect other 
blocks because of possible node name changes. You can generate multiple .edf files 
either by using the LogicLock option in the LeonardoSpectrum software, or by 
manually using a black box methodology on each block that you want to include in a 
LogicLock region.

After you create multiple .edf files with one of these methods, you must create the 
appropriate Quartus II project(s) to place-and-route the design.

Generating Multiple .edf Files Using the LogicLock Option
This section describes how to generate multiple .edf files using the LogicLock option 
in the LeonardoSpectrum software.

When synthesizing a top-level design that includes LogicLock regions, perform the 
following general steps:

1. Read in the Verilog HDL or VHDL source files.

2. Add LogicLock constraints.

3. Optimize and write output netlist files, or click Run Flow.
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To set the correct constraints and compile the design, perform the following steps in 
the LeonardoSpectrum software:

1. On the Tools menu, switch to the Advanced FlowTab instead of the Quick Setup 
tab.

2. Set the target technology and speed grade for the device on the Technology 
FlowTab.

3. Open the input source files on the Input FlowTab.

4. Click Read on the Input FlowTab to read the source files, but not begin 
optimization.

5. Click the Module PowerTab located at the bottom of the Constraints FlowTab.

6. Select a module to be placed in a LogicLock region in the Modules section.

7. Turn on LogicLock.

8. Type the desired LogicLock region name under LogicLock.

9. Click Apply.

10. Repeat steps 6-9 for any other modules that you want to place in LogicLock 
regions.

1 In some cases, you are prompted to save your LogicLock and other 
non-global constraints in a Constraints File (.ctr) when you click anywhere 
off the Constraints FlowTab. The default name is <project name>.ctr. This 
file is added to your Input file list, and must be manually included later if 
you recreate the project.

The command written into the LeonardoSpectrum Information or 
Transcript Window is the Tcl command that is written into the .ctr file. The 
format of the “path” for the module specified in the command should be 
work.<module>.INTERFACE. To ensure that you do not see an optimized 
version of the module, do not perform a Run Flow on the Quick Setup tab 
prior to setting LogicLock constraints. Always use the Read command, as 
described in step 4.

11. Make any other settings as required on the Constraints FlowTab.

12. Select Preserve in the Hierarchy section of the Optimize FlowTab to ensure that 
the hierarchy names are not flattened during optimization.

13. Make any other settings as required on the Optimize FlowTab.

14. Run your synthesis flow with each FlowTab, or click Run Flow.

Synthesis creates an .edf file for each module that has a LogicLock assignment in the 
Constraints FlowTab. You can now use these files with the incremental compilation 
flow in the Quartus II software.

1 You might occasionally see multiple .edf files and LogicLock commands for the same 
module. An “unfolded” version of a module is created when you instantiate a module 
more than once and the boundary conditions of the instances are different. For 
example, if you apply a constant to one instance of the block, it might be optimized to 
eliminate unneeded logic. In this case, the LeonardoSpectrum software must create a 
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separate module for each instantiation (unfolding). If this unfolding occurs, you see 
more than one .edf file, and each .edf file has a LogicLock assignment to the same 
LogicLock region. When you import the .edf files to the Quartus II software, the .edf 
files created from the module are placed in different LogicLock regions. Any 
optimizations performed in the Quartus II software using the LogicLock 
methodology must be performed separately for each .edf file.

Creating a Quartus II Project for Multiple .edf Files Including LogicLock 
Regions
The LeonardoSpectrum software creates .tcl files that provide the Quartus II software 
with the appropriate LogicLock assignments, creating a region for each .edf file along 
with the information to set up a Quartus II project.

The .tcl file contains the commands shown in Example 17–5 for each LogicLock 
region. This example is for module taps where the name taps_region is typed as the 
LogicLock region name in the Constraints FlowTab in the LeonardoSpectrum 
software.

These commands create a LogicLock region with auto-size and floating-origin 
properties. This flexible LogicLock region allows the Quartus II Compiler to select the 
size and location of the region.

f For more information about Tcl commands, refer to the Tcl Scripting chapter in 
volume 2 of the Quartus II Handbook.

You can use the following methods to import the .edf file and corresponding .tcl file 
into the Quartus II software:

■ Use the .tcl file that is created for each .edf file by the LeonardoSpectrum software. 
This method allows you to generate multiple Quartus II projects, one for each 
block in the design. Each designer in the project can optimize their block 
separately in the Quartus II software and preserve their results. Altera 
recommends this method for bottom-up incremental and hierarchical design 
methodologies because it allows each block in the design to be treated separately. 
Each block can be brought into one top-level project with the import function.

or

■ Use the <top-level project>.tcl file that contains the assignments for all blocks in the 
project. This method allows the top-level designer to import all the blocks into one 
Quartus II project. You can optimize all modules in the project at once in a 
top-down design flow. If additional optimization is required for individual blocks, 
each designer can use their .edf file to create a separate project at that time. You 
must then add new assignments to the top-level project using the import function.

Example 17–5. Tcl File for Module Taps with taps_region as LogicLock Region Name

project add_assignment {taps} {taps_region} {} {}
{LL_AUTO_SIZE} {ON}

project add_assignment {taps} {taps_region} {} {}
{LL_STATE} {FLOATING}

project add_assignment {taps} {taps_region} {} {}
{LL_MEMBER_OF} {taps_region}
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In both methods, use the following steps to create the Quartus II project, import the 
appropriate LogicLock assignments, and compile the design:

1. Place the .edf and .tcl files in the same directory.

2. On the View menu, point to Utility Windows and click Tcl Console to open the 
Quartus II Tcl Console.

3. At the Tcl prompt, type source <path>/<project name>.tcl r.

4. To open the newly completed project, on the File menu, click Open Project. 
Browse to and select the project name, and click Open.

f For more information about importing a design using incremental compilation, refer 
to the Quartus II Incremental Compilation for Hierarchical and Team-Based Design chapter 
in volume 1 of the Quartus II Handbook. For more information about importing 
LogicLock assignments, see the Analyzing and Optimizing the Design Floorplan chapter 
in volume 2 of the Quartus II Handbook.

Generating Multiple .edf Files Using Black Boxes
This section describes how to manually generate multiple .edf files using the black 
box technique. The manual flow, which was supported in older versions of the 
LeonardoSpectrum software, is discussed here because some designers want more 
control over the project for each submodule.

To create multiple .edf files in the LeonardoSpectrum software, create a separate 
project for each module and top-level design that you want to maintain as a separate 
.edf file. Implement black box instantiations of lower-level modules in your top-level 
project.

When synthesizing the projects for the lower-level modules and the top-level design, 
use the following general guidelines:

For lower-level modules:

■ Turn off Map IO Registers for the target technology on the Technology FlowTab.

■ Read the HDL files for the modules. Modules may include black box instantiations 
of lower-level modules that are also maintained as separate .edf files.

■ Add constraints.

■ Turn off Add I/O Pads on the Optimize FlowTab.

For the top-level design:

■ Turn on Map IO Registers if you want to implement input and/or output 
registers in the IOEs for the target technology on the Technology FlowTab.

■ Read the HDL files for the top-level design.

■ Black box lower-level modules in the top-level design.

■ Add constraints (clock settings should be made at this time).

The following sections describe examples of black box modules in a block-based and 
team-based design flow.
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In Figure 17–3, the top-level module A is assigned to one engineer (designer 1), while 
two engineers work on the lower levels of the design. Designer 2 works on module B 
and its submodules D and E, while designer 3 works on module C and its submodule 
F.

One netlist is created for the top-level module A, another netlist is created for 
module B and its submodules D and E, and another netlist is created for module C 
and its submodule F. To create multiple .edf files, perform the following steps:

1. Generate an .edf file for module C. Use C.v and F.v as the source files.

2. Generate an .edf file for module B. Use B.v, D.v, and E.v as the source files.

3. Generate a top-level .edf file A.v for module A. Ensure that your black box 
modules B and C were optimized separately in steps 1 and 2.

Black Box Methodology in Verilog HDL
Any design block that is not defined in the project, or included in the list of files to be 
read for a project, is treated as a black box by the software. In Verilog HDL, you must 
also provide an empty module declaration for the module that you plan to treat as a 
black box.

Figure 17–3. Block-Based and Team-Based Design Example
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Example 17–6 shows an example of the A.v top-level file. If any of your lower-level 
files also contain a black-boxed lower-level file in the next level of hierarchy, follow 
the same procedure.

1 Previous versions of the LeonardoSpectrum software require the attribute statement 
//exemplar attribute U1 NOOPT TRUE, which instructs the software to treat the 
instance U1 as a black box. This attribute is no longer required, although it is still 
supported in the software.

Black Boxing in VHDL
Any design block that is not defined in the project, or included in the list of files to be 
read for a project, is treated as a black box by the LeonardoSpectrum software. In 
VHDL, a component declaration is required for the black box.

Example 17–6. Verilog HDL Top-Level File Black Boxing Example

module A (data_in,clk,e,ld,data_out);
input data_in, clk, e, ld;
output [15:0] data_out;

reg [15:0] cnt_out;
reg [15:0] reg_a_out;

B U1 ( .data_in (data_in),.clk (clk), .e(e), .ld (ld),
.data_out(cnt_out) );

C U2 ( .d(cnt_out), .clk (clk), .e(e), .q (reg_out));
// Any other code in A.v goes here.

endmodule

// Empty Module Declarations of Sub-Blocks B and C follow here.
// These module declarations (including ports) are required for 
blackboxing.

module B (data_in,e,ld,data_out );
input data_in, clk, e, ld;
output [15:0] data_out;

endmodule

module C (d,clk,e,q );
input d, clk, e;
output [15:0] q;

endmodule
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Example 17–7 shows an example of the A.vhd top-level file. If any of your lower-level 
files also contain a black-boxed lower-level file in the next level of hierarchy, follow 
the same procedure.

Example 17–7. VHDL Top-Level File Black Boxing Example

LIBRARY ieee;
USE ieee.std_logic_1164.all;
ENTITY A IS
PORT ( data_in : IN INTEGER RANGE 0 TO 15;

clk : IN STD_LOGIC;
e : IN STD_LOGIC;
ld : IN STD_LOGIC;
data_out : OUT INTEGER RANGE 0 TO 15

);
END A;

ARCHITECTURE a_arch OF A IS

COMPONENT B PORT(
data_in : IN INTEGER RANGE 0 TO 15;
clk : IN STD_LOGIC;
e : IN STD_LOGIC;
ld : IN STD_LOGIC;
data_out : OUT INTEGER RANGE 0 TO 15

);
END COMPONENT;

COMPONENT C PORT(
d : IN INTEGER RANGE 0 TO 15;
clk : IN STD_LOGIC;
e : IN STD_LOGIC;
q : OUT INTEGER RANGE 0 TO 15

);
END COMPONENT;

-- Other component declarations in A.vhd go here

signal cnt_out : INTEGER RANGE 0 TO 15;
signal reg_a_out : INTEGER RANGE 0 TO 15;
BEGIN
CNT : C
PORT MAP (

data_in => data_in,
clk => clk,
e => e,
ld => ld,
data_out => cnt_out

);

REG_A : D
PORT MAP (

d => cnt_out,
clk => clk,
e => e,
q => reg_a_out

);

-- Any other code in A.vhd goes here

END a_arch;
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1 Previous versions of the LeonardoSpectrum software require the attribute statement 
noopt of C: component is TRUE, which instructs the software to treat the component 
C as a black box. This attribute is no longer required, although it is still supported in 
the software.

After you have completed the steps outlined in this section, you have a different .edf 
netlist file for each block of code. You can now use these files for the incremental 
compilation flow in the Quartus II software.

Creating a Quartus II Project for Multiple .edf Files
The LeonardoSpectrum software creates a .tcl file for each .edf file, which provides 
the Quartus II software with the information to set up a project. 

There are two different methods for importing each .edf file and corresponding .tcl 
file into the Quartus II software:

■ Use the .tcl file that is created for each .edf file by the LeonardoSpectrum software. 
This method generates multiple Quartus II projects, one for each block in the 
design. Each designer in the project can optimize their block separately in the 
Quartus II software and preserve their results. Designers should create a 
LogicLock region for each block; the top-level designer should then import all the 
blocks and assignments into the top-level project. Altera recommends this method 
for bottom-up incremental and hierarchical design methodology because it allows 
each block in the design to be treated separately; each block can be imported into 
one top-level project.

or

■ Use the <top-level project>.tcl file that contains the information to set up the 
top-level project. This method allows the top-level designer to create LogicLock 
regions for each block and bring all the blocks into one Quartus II project. 
Designers can optimize all modules in the project at once in a top-down design 
flow. If additional optimization is required for individual blocks, each designer 
creates a separate Quartus II project with each .edf file. New assignments must 
then be added to the top-level project manually or through the import function.

f For more information about importing designs using incremental compilation, refer 
to the Quartus II Incremental Compilation for Hierarchical and Team-Based Design chapter 
in volume 1 of the Quartus II Handbook. For more information about importing 
LogicLock regions, refer to the Analyzing and Optimizing the Design Floorplan chapter 
in volume 2 of the Quartus II Handbook.

With both methods, use the following steps to create the Quartus II project and 
compile the design:

1. Place the .edf and .tcl files in the same directory.

2. On the View menu, point to Utility Windows and click Tcl Console. The 
Quartus II Tcl Console appears.

3. At a Tcl prompt, type source <path>/<project name>.tcl r.

4. On the File menu, click Open Project. In the New Project window, browse to and 
select the project name. Click Open.
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5. To create LogicLock assignments, on the Assignments menu, click LogicLock 
Regions Window. Use the LogicLock Regions window to create LogicLock 
regions.

6. On the Processing menu, click Start Compilation.

Incremental Synthesis Flow
If you make changes to one or more submodules, you can manually create new 
projects in the LeonardoSpectrum software to generate a new .edf file when there are 
changes to the source files. Alternatively, you can use incremental synthesis to 
generate a new netlist for the changed submodule(s). To perform incremental 
synthesis in the LeonardoSpectrum software, use the script described in this section to 
reoptimize and generate a new .edf file for only the affected modules using the 
LeonardoSpectrum top-level project. This method applies only when you are using 
the LogicLock option in the LeonardoSpectrum software.

Modifications Required for the LogicLock_Incremental.tcl Script File
There are three sets of entries in the file that must be modified before beginning 
incremental synthesis. The variables in the .tcl file are surrounded by angle brackets 
(< >).

1. Add the list of source files that are included in the project. You can enter the full 
path to the file or just the file name if the files are located in the working directory.

2. Indicate which modules in the design have changed. These modules are the .edf 
files that are regenerated by the LeonardoSpectrum software and contain a 
LogicLock assignment in the original compilation.

1 Determine the LeonardoSpectrum software path for each module by 
looking at the .ctr file that contains the LogicLock assignments from the 
original project. Each LogicLock assignment is applied to a particular 
module in the design.

3. Enter the target device family using the appropriate device keyword. The device 
keyword is displayed on the Transcript or Information window when you select a 
target Technology and click Load Library or Apply on the Technology FlowTab.
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Example 17–8 shows the LogicLock_Incremental.tcl file for the incremental synthesis 
flow. You must modify the .tcl file before you can use it for your project.

Running the Tcl Script File in LeonardoSpectrum
After you modify the Tcl script, as described in “Modifications Required for the 
LogicLock_Incremental.tcl Script File” on page 17–25, you can compile your design 
using the script.

You can run the script in batch mode at the command-line prompt using the following 
command:

spectrum -file <Tcl_file> r

To run the script from the GUI, on the File menu, click Run Script, then browse to 
your .tcl file and click Open.

Example 17–8. LogicLock_Interface.tcl Script File for Incremental Synthesis

##############################################
#### LogicLock Incremental Synthesis Flow ####
##############################################

## You must indicate which modules have changed (based on the source files
## that have changed) and provide the complete path to each module

## You must also specify the list of design files and the target Altera 
## technology being used

# Read the design source files.
read <list of design files separated by spaces (such as block1.v block2.v)>

# Get the list of modified modules in bottom-up "depth first search" order 
# where the lower-level blocks are listed first (these should be modules 
# that had LogicLock assignments and separate EDIF netlist files in the 
# first pass and had their source code modified)

set list_of_modified_modules {.work.<block2>.INTERFACE .work.<block1>.INTERFACE}

foreach module $list_of_modified_modules {
set err_rc [regexp {\.(.*)\.(.*)\.(.*)} $module unused lib module_name arch]
present_design $module

# Run optimization, preserving hierarchy. You must specify a technology.
optimize -ta <technology> -hierarchy preserve

# Ensure that the lower-level module is not optimized again when 
# optimizing higher-level modules.
dont_touch $module

}

foreach module $list_of_modified_modules {
set err_rc [regexp {\.(.*)\.(.*)\.(.*)} $module unused lib module_name arch]
present_design $module
undont_touch $module
auto_write $module_name.edf
# Ensure that the lower-level module is not written out in the EDIF file
# of the higher-level module.
noopt $module

}
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Conclusion
The LogicLock incremental design flow uses module-based design to help you 
preserve performance of modules and have control over placement. By tagging the 
modules that require separate .edf files, you can make multiple .edf files for use with 
the Quartus II software from a single LeonardoSpectrum software project.

Conclusion
Taking advantage of the Mentor Graphics LeonardoSpectrum software and the 
Quartus II design flow allows you to control how your design files are prepared for 
the Quartus II place-and-route process, as well as to improve performance and 
optimize a design for use with Altera devices. The methodologies outlined in this 
chapter can help optimize a design to achieve performance goals and save design 
time with the LeonardoSpectrum software. For the best results with new designs in 
new device families, Altera recommends migrating to the advanced Mentor Graphics 
Precision RTL Synthesis software.

Document Revision History
Table 17–5 shows the revision history for this chapter.

f For previous versions of the Quartus II Handbook, refer to the Quartus II Handbook 
Archive.

f Take an online survey to provide feedback about this chapter.
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July 2010 10.0.0

■ Updated supported devices.

■ Removed Referenced Documents section.

■ Minor updates for the version 10.0 release.

November 2009 9.1.0
■ Minor updates for the Quartus II software version 9.1 release.

■ Removed Table 12–3, Inferring RAM Summary.

March 2009 9.0.0
■ No change to content.

■ Chapter 12 was previously Chapter 11 in software release 8.1.

November 2008 8.1.0
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